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SAVE TiME, No MORE RETYPING!

Congratulations on acquiring Readiris. This software package will undoubt-
edly be of great help in recapturing your texts, tables and graphics.

As efficient as computers are, you have to key in your information first. If you
have ever retyped a 15 page report or a large table of figures, you know how
tedious and time-consuming it can be. Use this state-of-the-art OCR package to
automatically enter text in your applications and you’ll acquire an unprecedented
level of efficiency and comfort!

Scan a printed or typed document, indicate the zones of interest - or have the
system detect them for you - and execute the character recognition. Documents
composed of many pages are processed from start to finish in a single effort. A
few mouse clicks beat long hours of work as Readiris converts your paper docu-
ments into editable computer files: it’s up to 40 times faster than manual retyping.

The wizard guides you through the OCR process comfortably: answer a few
simple questions and you’ll obtain quick and easy results with Readiris. You can
send the reading results directly to your wordprocessor and spreadsheet. To rec-
ognize faxes and convert PDF documents, you can drag the image files from the
Windows Explorer to the Readiris application window. Or right-click on an image
to send it prompty to Readiris.

Readiris recognizes tabular data and recreates them as worksheets or as table
objects inside your wordprocessor; your numeric data are immediately ready for
further processing.

Based on the Connectionist technology from I.R.1.S., Readiris represents the
best OCR has to offer. Font-independant feature extraction is complemented by
self-learning techniques derived from a proprietary neural network. The system
can learn new characters through context analysis: linguistic knowledge about
syllables and words improves the OCR performance.

Readiris supports up to 104 languages: all American and European languages
are supported, including the Central-European languages, the Baltic languages,
Greek and the Cyrillic (“Russian™) languages. (Optionally, you can read four
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Asian languages - Japanese, Simplified and Traditional Chinese and Korean.)
Readiris even copes with mixed alphabets: the software detects “Western™ words
that pop up in Greek, Cyrillic and Asian documents - many untranscrible proper
names, brand names etc. are written using the Western symbols.

Readiris uses linguistics during the recognition phase, not after it. As a direct
result, Readiris recognizes documents of all kinds with top accuracy, including
low-quality documents, faxes and dot matrix printouts. It copes beautifully with
badly scanned and copied documents containing too light or dark font shapes.
Joined characters (“ligatures™) are resolved and fragmented forms, such as dot
matrix symbols, are recomposed.

User verification in pop-up style not only flags doubtful characters but also
increases the system’s precision. All solutions confirmed by the user are memo-
rized, increasing speed and confidence as you go along. Using Readiris means
rendering it more intelligent each time! This powerful learning tool allows you to
train Readiris on special characters such as mathematic symbols and dingbats
but also to handle distorted fonts as you will find in real documents.

To increase your productivity further, Readiris not only recognizes your texts,
but can format them for you as well! Make use of “autoformatting” and Readiris
recreates a facsimile copy of the scanned document: the word, paragraph and
page formatting of the original document are retained.

Similar typefaces are used, the point sizes and typestyles as used in the source
document are maintained across the recognition. The placement of columns, text
blocks and graphics follows your original documents. And as Readiris supports
greyscale and color scanning effortlessly, you can recapture any graphics - be
they lineart, black-and-white photos or color illustrations. When a document con-
tains tables, Readiris reorganizes them in real cells and recreates the cell borders
of the original tables.

In other words, Readiris allows you to archive a true copy of your documents,
be it editable and compact text files instead of scanned images! Various levels of
formatting are available, the choice is up to the user.
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You can even recognize business cards with Readiris: scan your business
cards, recognize them and convert them into an address database. Think of your
last exhibition when you came back with an entire stack of business cards and it
took your secretary two days to encode them!

The card’s data is extracted automatically from the image and the recognized
data is assigned to specific database fields. Readiris extensively uses a knowl-
edge database, thus acquiring the necessary intelligence to discriminate the first
and last name, a city and its state, a telephone and a fax number etc. The result-
ing data can be sent directly to your contact management software such as
Microsoft Outlook (Express) or any vCard compliant application.

Readiris supports a wide range of popular scanners: numerous flatbed scan-
ners, sheetfed scanners, “all-in-one™ devices or “MFPs” (“multifunctional pe-
ripherals™) and digital cameras can be used. Readiris also supports the Twain
scanning standard and some scanning platforms.
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Chapter 1
INSTALLATION

This chapter discusses the system requirements and installation of the Readiris
software.

SYSTEM REQUIREMENTS

This is the minimal system configuration required to use Readiris:

U a 486 based Intel PC or compatible. A Pentium based PC is recom-
mended.

U 32 MB RAM. 64 MB RAM is recommended to process greyscale and
color images.

U 110 MB free disk space. 95 MB of disk space suffices when you leave
the sample files on the CD-ROM.

4 the Windows XP, Windows ME. Windows 2000, Windows 98, Windows
NT 4.0 or Windows 95 operating system.

Note that some scanner drivers may not work under the latest Windows
version(s). Refer to the documentation supplied with your scanner to see which
platforms are supported.

INSTALLING THE READIRIS SOFTWARE

The Readiris software is delivered exclusively on an autorunning CD-ROM.
To install, simply insert the CD-ROM in your CD-ROM drive and wait for the
installation program to start running. Follow the on-screen instructions.
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Should the installation not begin to run when the CD-ROM is inserted in your
CD-ROM drive, run the setup program MENU.EXE to install the software.

Users of Windows XP, Windows 2000 and Windows NT must ensure that
they have the necessary access rights - contact the system administrator if
necessary.

Some installation options are offered. Be sure to install the linguistic data-
bases of all languages you intend to read. By default, all lexicons are installed.
You are recommended to install the sample images which are used in the tuto-
rials of this manual.

InstallShield Wizard

Select Components

Choosze the components Setup will install.

Languages 4 Description
Sample Images 177K | Includes the linguistic :
Electronic Manual erdd databases. Install the lexicon

| of all languages you intend to

Adobe Acrobat Feader B4R K| | recognize.
Change... j
Space Required on C: 92398 K

Space Available on C: OKB

< Back MHext > I Cancel I

Similarly, install the Acrobat Reader software required to access the software
documentation, should this be necessary. The electronic manual is by default
copied to your hard disk. You can also leave it on the CD-ROM.
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The submenu "[.LR.1.S. Applications - Readiris" under the "Programs" menu is
created automatically by the installation program.

G 1.R.15. Applications | R
| ) misren »

| fa Readiis »

@ LR.L5. on the Internet
| —S_ Readiris
Uninstall Readiris
@ User's Manual

The same holds for a shortcut to Readiris on the Windows desktop. As a
result, you are able to start Readiris directly from your desktop.
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UNINSTALLING THE READIRIS SOFTWARE

There are only two correct ways of uninstalling Readiris: using the Readiris
“uninstall” program and using the Windows (un)install wizard. You are strongly
recommended 7ot to uninstall Readiris or its software modules by manually eras-
ing the program files.

Readiris “uninstall” program

Select "Uninstall Readiris" under the submenu "I.R .1.S. Applications - Readiris"
to start the Readiris “uninstall” program and follow the on-screen instructions.

M@ LR.IS. Applications  »

Cardiris ~ »
IRISPen

ﬂj I.R.1.5. on the Internet
@ Reading Asian docurments
[.:I Readiris

,!’ Uninstall Readiris

ﬁ User's Manual

Windows (un)install wizard

Execute the following steps to make use of the Windows (un)install wizard.

U Click "Settings" under the "Start" menu of Windows and go to the "Con-
trol Panel".

U Click the icon "Add/Remove Programs" under the control panel.
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¥ Add or Remove Programs

Currently installed programs: Sork by:
Change or rS
i = adabe Acrobat Size  78,35MB —
Programs | sdabe Photoshop Size  9,10MB
& cardiis Size  35,66ME
E <a
' IRISPen Size 2,74MEB
add Mew i i
Programs ﬁl McAfee YirusScan Size 15,90MB
% Micrasoft Office ¥P Professional Size  174,00ME
[8 Readiris
AddiRemove
‘Windows
Components

To change this program o 0 compute [Remave, Change/Remove

(1) RealOne FPlayer Size  22,10MB

v

Close

U Follow the on-screen instructions to remove the Readiris software.

INSTALLING SOFTWARE OPTIONS

There’s a single software option available for the Readiris software: the “Asian
OCR add-on”. It allows you to read Japanese, Traditional Chinese, Simplified

Chinese and Korean. This software is again delivered on an autorunning CD-
ROM.
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& AR
Hide Back Home: Prirt

Lontents ] Index ] §earch]

Optionz

7] welcome to the Readiris help
Introducing OCR
Recognizing Docurments
How to...?
Reference Information

(7] Software versions and Options
[3] software versions

Asian R 'Add-an'

@ A waord about the Asian languag
ﬁ Crdering by e-mail

Product Reqistration
Product Support

ILR.IS.

Software Option Asian
OCR "“Add-on”

Reading Asian documents

The software option *Asian OCR Add-On*
offers recognition of the Asian languages
Japanese, Simplified Chinese, Traditional
Chinese and Korean.

Tip: a large number of Asian languages such as
Malay, Tagalog etc, are supported by the
“standard” Readiris software because they use
the Latin alphabet!

What it takes - the working environment

e« To view and edit Asian documents, you can
LUse Word 2002 (Office XP) or Word 2000
{Office 2000} or install a localized Asian
version of the Windows operating system.

e Alternatively, you can run specialized
“emulating” {or *overlay”) software such as
Union'ay AsianSuite or TwinBridge
AsianBridge on a Western version of
Windows to correctly represent the
ideograms of these languages.

By installing this option, specific documentation becomes available that dis-

cusses how you can recognize Asian documents.
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B LR.IS. Applications  » Cardiris  »
IRISPen »
@ Readiis » @ I.R.L5. on the Internet

@ Reading Asian documents
[.:I Readiris

ﬂ Uninstall Readiris

E User's Marual

INSTALLING RELATED PRODUCTS

Depending on the software bundle you acquired, Readiris may be supplied
with an evaluation version of the related product Cardiris, a business card or-
ganizer.

If this free software package is included on your Readiris CD-ROM, it is also
installed using the autorunning CD-ROM and following the on-screen instruc-
tions.

Contact [.LR.1.S. to learn more about complementary software; the command

"Contact I.R.I.S." under the "Help" menu of Readiris details in which ways you
can get in touch with LR.LS.
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Hide Back Home nt [Options

Contents ] Index ] ﬁearch]

e How to Get in Touch
elcame o 1= £eadiris nelp -
i Introducing OCR W'th I.R.I.S.

Recognizing Documents

How to...? ) Head Office {Belgium)
Reference Information Phone: 32-10-45 13 64
Software Versions and Options Faw: 32-10-45 34 43
Product Reqistration
@ Product Support I.R.1.S. on the Internet

(O1r1s. [.R.I.5. home page: htfp:/fwwwirislink.com
Readiris web site: http: /fwww readiris.com
On-ing shop: httpe/fshop.irislink.com
E-mail info: infod@irislink.com

@ Register your Readiris licence
7] Readiris registration form

I_E How to get product suppart ) E-mail sales: sales@irislink .com

i Getting product support by e-mail E-mail support: supportd@irislink.cam

[7] How to get in touch with LR.I.S,

fa Getting in touch with I.R.IS, by e-mail usA Office {East Coast)

@ How to acquire software options Phone: 1-561-395 7831 / 800-447-4744
&3 L.R.LS. on the Internet Fax: 1-561-347 6267

ush Office (West Coast)
Phone: 1-480-854-3111 / 800-7USAIRIS
Fax: 1-480-854-2929

France Office
Phone: 0810-00 19 27
Fax: 0810-42 41 43

An application icon in the submenu "[.R.I.S. Applications - Readiris" under the
"Programs" menu takes you directly to the .LR.I.S. home page. So does the
Readiris startup screen and the command "[.R.I.S. on the Internet" under the
"Help" menu of Readiris.
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B IR.LS. Applicstions »

Cardiris  »
IRISPen  »
fﬁ Readiris  »

3 1.R.1.5. on the Internet
[.‘] Readiris

ﬂ Uninstall Readiris

E User's Manual

INSTALLED FILES

The installation program has created a folder where the Readiris files are
located. Never try to uninstall Readiris or some of its modules by manually eras-
ing the program files, use the Readiris “uninstall” program or the Windows
(un)install wizard instead. See above.

Read Me files and documentation
README.DOC “Read Me” file
MANUAL.PDF User’s manual (in Adobe Acrobat format)

Scanner drivers

Finally, you may find some scanner drivers on the Readiris CD-ROM under
the folder "Drivers".

LR.LS. offers no guarantee that drivers are supplied for your scanner model
or that the drivers supplied on the Readiris CD-ROM will work (well) with your
scanner model.

Don’t hesitate to contact your scanner manufacturer or its representative should
problems with scanner drivers continue. Most manufacturers allow you to down-
load the latest versions of the scanners drivers from their web site.
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REGISTER TO VOTE!

Don'’t forget to register your Readiris licence! Doing so will allow us to keep
you informed of future product developments and related I.R.I.S. products. The
registration benefits, including free product support and special offers, are strictly
limited to registered users.

You can register in many ways: by sending in your registration card or faxing
its electronic counterpart, by calling .LR.I.S. during working hours and by filling
out a registration form on the LR I.S. web site!
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E? Readiris help

o e AR

Hide Back Home Frint  Options

Cantents l Index ] ﬁearch]

Register Your Readiris Licence

Wwelcomne to the Readiris help
Intraducing OCR

o Why you should register
Recognizing Docurnents

How to..? _ e Registering allows us to keep you informed of
Reference Information future product developments and related
Software Versions and Options I.R.I.S. products,

QQ] Product Reagistration
? your Readiris licence

e Registering entitles you to free product support

Readiris registration form and special offers.
4 Reqgistering by e-mail .
ﬁodugc SuppgrtY & Depending on the software bundle, youll
g LRIS receive the softkey in return as may be needed

to continue using Readiris after one month.

How to...?

Registration wizard

Click ﬂ to start the reqistration wizard,
Mail

Send in your registration card.

WWW

Click here to access the Readiris registration form
on the LLR.IS. web site.

The Readiris registration wizard as you’ll find under the menu "Register" of
the Readiris software can guide you through the registration process comfort-
ably.
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Readiris registration wizard

‘welcome to the Readins registration wizard.
It alloves you to register your Reading software licenze.

Regiztenng allows us to keep you informed of future
product developments and related 1.R.1.5. products.

Reaiztering entitles wou ta free product suppart and
special offers.

Depending on the software version you acquired, you’ll receive the softkey
in return as may be needed to continue using the Readiris software after one
month.

GETTING PRODUCT SUPPORT

The command "Product Support" under the "Help" menu of Readiris details
how you can get technical support. Please describe the phenomenon you experi-
ence clearly and include all relevant data concerning Readiris, your scanner and
your computer system.
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E? Readiris help

E AT

Hide Back Haome Fririt

Contents ] |nde ] gearch]

Welcomne to the Readiris help
Introducing OCR

Recognizing Documents

How to...?

Reference Inforrmation
Software Versions and Options
@ Product Reqgistration

@ Product Support

o

How to get in touch with I.R.I.5.
@ Getting product support by e-mail

@ RIS,

Optionz

How to Get Product Support

Free technical support is offered to all
registered customers. (Reqistering also
entitles you to special offers.)

Europe

Hotline: 22-10-45 132 64 (working hours)
(all major languages)
Fax: 32-10-45 34 43

uUsa

Haotline: 1-561-395-7831 / B00-477-4744
(working hours)
Faw: 1-602-507 3418

WWwW

wewew irislink.comfsupport.html
(troubleshooting info)
Click here to access the troubleshooting info.,

E-mail
suppartd@irislink.com
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Chapter 2
GUIDED TOUR

Readiris is a state-of-the-art OCR package equipped with numerous advanced
features. We will discuss all major features in this chapter and add many tips and
hints concerning the use of Readiris.

STARTING THE SOFTWARE UP

Click on the Readiris application in the submenu "L R.L.S. Applications - Readiris",
or click on the shortcut to the Readiris application on your desktop.

Cardiris ~ »
IRISPen
'ri Readiris ~ » @ 1.R.L.5. on the Internet

[ 1.R.IS. applications  »

ﬁ Uninstall Readiris
ﬁ Iser's Manual

The Readiris startup screen and application window are displayed. The startup
screen displays the version and copyrights of the Readiris software. It also gives
direct access to .LR.I.S.’s home page - simply click on the URL to visit the
LR.LS. web site. Clicking the mouse anywhere else makes this screen disap-
pear.



Readiris

Readitis releaze 5.0
@ 2002
Image Recognition Integrated Systems 4,

All rights reserved

For more info on nevy products and
|Upgrades, vizit our web site
ww.irislink.com

The next window concerns the OCR wizard; click "Cancel" for the time be-
ing.

THE FIRST-TIME STARTUP

Depending on the software bundle you acquired, the first startup may be spe-
cial: you may be prompted to register your licence.

If this is the case, the use of Readiris is limited to 30 days, and by registering,
you receive a free softkey from I.LR.I.S. to continue using the software after the
first month.

It takes your identification number to generate the softkey; be sure that this
number is available or mentioned when you register your licence.
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X

Readiris
The identification humber on thiz machine iz

JCM42535C033038 33032535444808030 Help

To enable this software, you need a key.
Fleaze contact |.FR.1.5. to obtain thiz key

Enter your key number:

0k | | don't have thiz key

Di1SCOVERING THE READIRIS INTERFACE

The Readiris application window not only contains command menus but also
two button bars that give quick access to all frequent commands. Initially, some
command menus are dimmed: they concern the preview. As long as no image is
opened, they are unavailable.
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File Ecit  Seftings view  Process Learn Register Help

English

The same goes for the image toolbar on the right side of the application
window: it contains all commands you need during the image preview. The main
toolbar on the left gives quick access to all frequent general commands.

To learn which command corresponds to a certain button, hold your mouse
pointer over it for a while: a tooltip will tell you what the button does.
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[8 Readiris

Edit - Settings ¥ Process Le

Capture image

The window pane or image zone is where the scanned images are displayed.

You can drop image files onto the image zone (and on the Readiris icon) to recog-
nize them.

As soon as pages gets processed, an additional toolbar, the page toolbar, is
added on the right side: it represents the various pages of the document and gives
access to the page commands using the right-click (the "Context" menu).
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GETTING STARTED WITH A FIRST TUTORIAL

The best way to become familiar with the operation of Readiris is undoubtedly
by using it. A number of prescanned images is provided with the software; they
allow you to get started even when there is no scanner connected to your com-
puter. Let’s turn to these now.

The "Source" button on the main toolbar determines whether you are going to
use a scanner or a prescanned image as image source.

Color, greyscale and black-and-white images are supported on an equal basis.
Readiris allows you to open Adobe Acrobat PDF documents, JPEG images, Paint-
brush (PCX) images, DCX fax images (a multipage version of the Paintbrush
format), PNG images, TIFF images (uncompressed, LZW, PackBits, Group 3
and Group 4 compressed), multipage TIFF images and Windows bitmaps (BMP).

This capability is particularly useful to convert your faxes into editable text
files.

As you are going to open a prescanned image, you should select the disk, and
not the scanner, as image source with the "Source" button.

Next, click the "Open" button. (When you select the disk as image source, the
"Scan" button is replaced by the "Open" button and the corresponding "Scan"
command under the "Process" menu is replaced by the "Open" command.)

open

You could also select the command "Open" from the "File" menu and open a
prescanned image directly - this works even if your scanner operates as current

image source.
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You are invited to select an image file. Select the file ENGLISH.JPG in the
Readiris folder. As this sample file is a color image, it is not only read from disk:
a “binarized”, black-and-white version is created for the OCR process.

Canverting

Finally, the image is displayed in the image zone. The page toolbar indicates
that a single page is loaded into Readiris.

Loading D:\Readiizhenglizh.jpg...
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File Edit Settings Yiew Process Learn Register Help

A word about OCR

‘The aim of OCR is 4o amtamatically enter printsd text docwments in a very effective and
[ow cost way, Although the first research and development on Optical Characler
Recognition [C_J(_l\] began more than 30 wears ago, this technology is skl imknewn by
masl of the people who could vse it for Lhc'lr decument enkry appllcallcns

Wew, you can use this effective ool in your affice and vnburdem yourself wath the
fagtidions task of relvping printed toxt. QCR is the most efficient and fastest tonl to entet
texts into your computer autornatically,

The: document is read by your seamner. This device acls as the "eve” af vour computer
and sends il the image. Al this efop, The document image is anly a meacingzless clousd of
black points, pixels, on a white background, The OCR sottware has to exlracl lext
information from these pikels: it has to recognize shapes by asstgning characlors.

I'he system extensively uscs linpuistic databases when analyzing the context, in this way
firuling correct solutions for difficudt cases. The user rains the sollware on new
characters and typestyles, which are recognized sutematically later o, This learniey
madule allows you to read wirlwally any Tont, Tn other words: the software gets more
inelligen each me you use il

A third way of opening prescanned images is the use of “drag and drop”
drag images from the Windows Explorer onto the Readiris image zone or on the
Readiris icon and they are promptly opened.
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You can even open images from within the Windows Explorer: right-click an
image file and select the command "Recognize" from the "Context" menu. (This
command only appears when the file’s file type is supported.)
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That does not mean the OCR is promptly executed: to give the user full flex-
ibility, Readiris is simply started up and the image is opened.

The image toolbar on the right side of the Readiris application window con-
tains all commands you need during the image preview: tools to indicate the zones
of interest, to rotate the image, zoom in and out etc.

Z.00MING IN ON IMAGES

Readiris has several commands that allow you to zoom in on a scanned im-
age, for instance to verify the scanning quality.

The image toolbar contains buttons that allow you to zoom in at real size, to fit
the image to the page width and to fit the entire image in the preview window.
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The "View" menu contains the same commands and adds two extra zoom levels:
you can display the image at 50% and 200% of its actual size. At actual size, a
screen pixel corresponds to an image pixel. (Shortcuts are available for all zoom

levels!)
View
ﬂ v Fit ba indos

ﬂ Fit ko wWidth Chrl+t
Actual Size Chrl+1
L!l 200% Actual Size Chel+2

Also notice that the zoom levels are available on the right-click. Click with the
right mouse button to invoke the "Context" menu and select the appropriate zoom
level.

[§ Readiris - C:\Program, Files\Readiris}english. jpg (page 1 of 1)
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e The aim of OCR

Englizh

Finally, you can double-click the right mouse button over a region of the scanned
image to zoom in at real size immediately. Repeat the operation to zoom out
again.
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ONE, DECOMPOSING A SCANNED IMAGE

Now that the image is scanned, you have to indicate which parts you want to
convert into editable text by drawing frames, so-called “windows™, around the
zones of interest.

Actually, Readiris will do this for you automatically when the option "Page
Analysis" is enabled on the main toolbar.

i

Page Analysis

Page &nalysis

Automatic page decomposition is particularly useful when columnized texts
and documents with a complex page layout, possibly including graphics and tables,
are recognized.
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fastidions task of netwping printed fext. QR is the most efficient and fastest tonl to enter
texts into your computer autornatically,

The: document 1 read by your seamner. This device acls as the "eve” af vour computer]
and sends il the image. Al this efop, The document image is anly a meaningless clousd of
black points, pixels, on a white background, The OCR sottware has to exlracl lexE
information from these pikels: it has to recognize shapes by asstgning characlors.

fineling correct solutions for diffimdt cases. The user trains the sollware on new
characters and typestyles, which are recoghizod sutomatically later on, This learniry
madule allows you to read virlually any |
inelligen each e you use il

L In other wards: the software gets more

‘The system extensively uses linguiskc data'£es when analyzing the context, in this way

Page decomposition uses three window types: text, graphic and table win-
dows. Readiris discriminates text blocks, tables and graphic zones containing
photos, illustrations etc. on the page. (Saving graphics and recognizing tables will
be discussed at great length below.)

A color code indicates the window type: text zones have a yellow border,
graphic windows have a blue border and tables a purple border.
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The number of windows is indicated at all times in the tooltips of the "Text
Window", "Graphic Window" and "Table Window" tools.

1 El
Draw ket window: 4 Draw bable window: 0

Page analyisis is fast, skew-tolerant and highly accurate: it traces complex,
“irregular” shapes.

Draw graphic window: 1

l y
DOWNSIZED

:apa-
-ane- DISPLAY: Sceptre’s
te of CD-1112T LCD panel

onn 18 sosvelte that you can tuck it in

The page analysis will even detect zones where you get white text on a
black background. Recognizing such inserts is no problem: while the preview
displays the scanned document correctly on-screen, Readiris “inverts™ the image
when the need arises to recognize such text blocks! (You can have your scanner
generate fully inverted images to process pages with white text on a black back-
ground. See below.)

ONE AND A HALF, SORTING WINDOWS

Readiris not only detects the various blocks, but also sorts them: the zones are
sorted top-down, left to right by default to cope with columnized documents.

Evidently, you can modify the sort order. To do so, click the "Sort" button on
the main toolbar. The mouse cursor becomes a pointing hand as soon as the “sort
mode” is enabled.

Click on the windows you want to include. Windows you do nof click on are
simply ignored, excluded from recognition. It’s easy to see which windows are
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selected and which aren’t: the selected windows have their full color, non-se-
lected windows have a lighter color tone.

'8 Readiris - C:\Program Files\Readirislenglish.jpg (page 1 of 1)
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black points, pixels, on a white background, The OCR sottware has to exlracl lexE
information from these pikels: it has to recognize shapes by asstgning characlors.
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ielligen each lme you use il

Page analysis is enabled by default. To force Readiris to decompose the cur-
rent page - because you disabled page analysis by accident, because you erased
some windows erroncously and want to redo the page analysis etc. -, you can
simply click the button "Analyze Page" in the image toolbar.
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Select the document language before executing the page analysis when you
are dealing with Asian documents. Specific routines are used for these languages:
the interline spacing of Asian documents is in most cases bigger than in Western
documents, the text is made up of small icons (“‘ideograms™) that could casily be
seen as graphic zones in Western documents and the text may run from top to
bottom, from right to left. And if you forgot to select the proper language, select
it afterwards. Readiris re-executes the page analysis automatically!

Some documents have many “stray” dots on the page, may generate a black
page border around the actual image etc. To erase all small windows - it’s as-
sumed they don’t contain any text - and re-sort the remaining zones, you can
click the command "Delete Small Windows" under the "Edit" menu.

Delete Small Windows  ChrlH+M

Two, WINDOWING A SCANNED IMAGE MANUALLY

Page analysis is the automatic way of windowing a scanned page. Alterna-
tively, you can zone an image manually with the windowing tools of Readiris.

Diraw test window: 0

@ |Dral.-~\l graphic: window: D|

‘@ [Crraw table window: 0]

[=)

k

To draw a rectangle around a zone of interest, select the corresponding tool in
the image toolbar, click the cursor in the upper left corner of the window, stretch
the window by moving the mouse to the lower right corner and click again. (Sides
smaller than 1 mm are not allowed, they wouldn’t even contain a single character
anyway.)
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The windows are automatically sorted in the order of creation: arrows indi-
cate the sort order.

You can also frame “irregular” text blocks by drawing polygonal windows
around them. Non-rectangular windows are created by merging rectangular zones:
as soon as two rectangles (of the same type) intersect, they become a single
window automatically! In a way, you’re building a house by adding one room
after the other... (Creating polygonal table windows doesn’t make any sense.)

I8 |Readiris - C:\Program Files\Readinislenglish. jpg (page 1 of 1)
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Furthermore, manual windowing can be combined with window sorting: you
can draw new windows even when the “sort mode™ is enabled. You then use
sorting to include a number of detected windows and manually create some other
windows where the page analysis didn’t yield the appropriate results. As soon as
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you start creating windows in the “sort mode”, all zones you didn’t select are
promptly erased!

To modify, move and delete windows, you need to select them first. To do so,
select the "Window Selection" or “arrow” tool in the image toolbar and click
inside a window. Rectangular markers now appear at each corner and in the
middle of the window sides.

x| A word about OCR

To unselect windows, click the mouse button elsewhere. To select addi-
tional windows, hold down the Shift key while clicking on these extra windows.
To select a window and the included windows (of another type), hold down the
Ctrl key while clicking on the main window.

So much for selecting windows. To modify a window, select it, put your mouse
cursor over a marker and drag the side to change the window size.

To move a window, simply select it and drag it to another location.

To delete windows, select them and choose the "Cut" or "Clear" command
from the "Edit" menu. The "Cut" command cuts the window(s) to an internal
buffer, "Clear" erases the window(s) irretrievably. When you paste zones, they
are inserted in their original position, and you have to drag them to their new
location.

In fact, all familiar commands from the "Edit" menu apply to the windows:
you can delete, cut, copy and paste them! The "Undo" command also applies: if
you have unfortunately deleted, moved, resized etc. some windows, "Undo" will
cancel the last operation.
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Cuk Chrlx
Copy ChrHC
Paste Chrl+y
Clear Del

Delete Small Windows  CkrlH+M
Select All ChrlHa

Also note that shortcuts are available for all commands! Let’s give an ex-
ample: to erase all existing windows, you can choose the command "Select All" or
its shortcut Ctrl+A and click the command "Clear" or its shortcut Delete. You are
now ready to recreate the necessary layout. To restore the previous layout, you
can choose "Undo" or the shortcut Ctrl+Z.

THREE, SAVING WINDOWING TEMPLATES

The resulting windowing layouts can be saved as zoning templates for fu-
ture use with the command "Save Layout" under the "File" menu and loaded into
memory with the command "Load Layout".

Save Layouk,.. g

If you have to recognize documents with a similar layout, for instance a 50
page report where the header and footer should be excluded for obvious reasons,
a single template can be applied to zone all 50 pages.

When you load a template into memory, page analysis is disabled automati-
cally. The zoning template remains active until you re-enable page analysis on the
main toolbar.

Actually, there’s a nice alternative for zoning templates: the preview tool Ig-
nore Exterior Zone limits the page decomposition to the “cropped” portion of the
image.



Select this tool and frame the portion of the image you want to process. When
you’re dealing with a multipage document, you can exclude the same outer zone
from page analysis on every page. (Re-execute the page analysis to cancel the

Ed

image “cropping”, or change the zones manually.)

[8 Readiris
File Edit Settings
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READIRIS TAKES YOU AROUND THE W ORLD

Assuming that the windows are correctly defined, you are now almost ready
to execute the character recognition. We say “almost”, because we haven’t veri-
fied the language and document settings yet.

The language setting can be found on the main toolbar.

¥

Englizh

Click the "Language" button to modify the document language.

Language

™ Nurmeric

.

|English -

Chinesze [Simplified) ~ C |
Chineze [T raditional) 3 ance
Corgican
Croatian
Czech
Danizh
Dutch

Estonian
Faroese

Fiian

Fitmizh
French

Frizian

Friufian
Galician
Ganda
Geman
Greek
Greek-Englizh
Greenlandic
Haitian Creols
Hani hr
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You can press a letter key to move to it directly: if English is currently se-
lected, and you want to select Occitan, you can click the "O" key on your key-
board to go directly to the Occitan language. When several languages have the
same initial, press the letter several times to go through the options. Let’s give an
example: Readiris reads English and Estonian. By pressing "E" once, you select
English, by pressing "E" a second time, you select Estonian, and by pressing "E" a
third time, you’re back on English. (To go to another letter, say T, press BackSpace
before you enter the "T" character.)

Readiris is far from limited to English: up to 104 languages are supported! All
American and European languages are supported, including the Central-Euro-
pean languages, Greek, Turkish, the Cyrillic (“Russian”) and the Baltic languages.

Optionally, you can read Asian documents: the extra module “Asian OCR
add-on” offers recognition of Japanese, Simplified Chinese, Traditional Chinese
and Korean. (Simplified Chinese is used on China’s mainland and in Singapore,
where Traditional Chinese is used by Hong Kong, Taiwan, Macau and the over-
seas Chinese communities.)

Also note that the British and American - or should we say “international”? -
variants of the English language are distinguished.

It takes the appropriate Windows configuration to display Central-European,
Greek, Turkish, Cyrillic and Baltic characters. You may have to install the Win-
dows multilanguage support before your Windows system is able to cope with
these languages.

On a Windows XP, 2000 and Windows NT 4.0 operating system, select the
icon "Regional Settings (and Languages)" under the "Control Panel".



USER’S GUIDE

Regional and Language Options

Regional Options | Languages |Advanced

Test zervices and input languages
To wiew or change the languages and methods you can uge to enter

test, click Details.

Supplemental language support
Mozt languages are installed by default. To ingtall additional languages.
select the appropriate check box below.
Install files for complex script and right-to-left languages (including
Thai)

Install files for E azt Agian languages

k. ] [ Cancel ] [ Apply

On a Windows ME and 98 operating system, select the icon "Add/Remove
Programs" under the "Control Panel" to find out if the module “Multilanguage
Support™ is installed on your PC.



Add/Remove Programs Properties
Install/Uninstall  #indows Setup | Startup Disk |

To add or remove a component, click the check box. A shaded box
meansz that only part of the component will be installed. To zee
what'z included in a companent, click Details.

LComponents:

@ Microsoft Exchange 42ME =]

[ @& Microsoft Fax 0.0MB

Q tultilanguage Support 10.4 MB

82 Multimedia 1.1 ME

1 [ The Microsoft Metwark 0.0ME |+

Space required: 1.2 MB

Space available on disk; 29.3 MB
Description

Includes options ta change keyboard, zound, dizplay. and
mouse behavior for people with mobility, hearing and wvisual
impairments.

1 of 1 components selected Details... |
Hawe Disk... |
(] I Cancel | Lppl |

To view and edit Asian documents, you can install an Asian version of the
Windows operating system or run specialized “emulating” software (such as
UnionWay AsianSuite or TwinBridge AsianBridge) on a Western version of Win-
dows to correctly represent the ideograms of these Asian languages. Finally, you
can use Word 2002 or 2000 to view and edit such documents: Office XP and
2000 were specifically designed to cope with documents in many different lan-
guages.

Refer to the Readiris “Read Me” file for more information on this subject.
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Selecting the proper document language is imperative. Based on the selection
of'a language, the software knows which symbol set to recognize. Multi-linguis-
tic support ensures that “exotic” characters such as ¢, B, i, y and o are recog-
nized correctly.

Secondly, the software extensively uses linguistic databases to validate its
results. Suppose that you have to read the word "president" where an ink stain
makes the "r" look like an "f". Looking things up in the English lexicon, Readiris
will detect autonomously that the word "president" is being read and that it doesn’t
make any sense to recognize the symbol "f". This “self-learning” technique is
of course highly dependent on the linguistic context.

Linguistics offer useful help to solve ambiguous cases such as an "O" which
might be mistaken for a '0'. Another typical example is the letter "1" and number
'1' which have an identical form in many fonts - think of texts produced on old
typewriters! The linguistic context helps to determine whether you are dealing
with "l" or '1".

The illustration below shows various shapes of '1' and "1". The shapes on the
first line are unambiguous, the shapes on the second line are ambiguous, but
linguistics can solve them. When the context does not suffice, the user inter-

193 1950s.
Well, Rossellini

READIRIS CHANGES LANGUAGES AS NEEDED

But the buck doesn’t stop here: Readiris can switch languages in the middle of
a sentence without any help from the user! When Western words pop up in
Greek, Cyrillic or Asian documents - many untranscrible proper names, brand
names etc. are written using the familiar Western symbols -, Readiris can switch
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to the correct alphabet automatically. In other words, you can activate a mixed
alphabet of Greek, Cyrillic or Asian and Western characters.

Be sure to select "Greek-English" or the appropriate Cyrillic language setting
- for instance "Byelorussian-English". In other words: don’t try to just select
"Greek" or "Byelorussian" as document language and hope that the Western sym-
bols will come out fine!

Here’s an example where a Russian text contains some English words - open
the image file ALPHABET.TIF if you want to try it for yourself!

I8 Readiris - C:\Program Files\Readiris\alphabet.tif {page 1 of 1) =13
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Russian - English
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Heemor yro paspaboTka 3ToH

HeH3BecTHA  [MHpokod  Tmylauke  gns
aBTOMATHYECKOTO BBOAR MaTepuata o
JOKYMEHTOR,
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The end result looks like this when opened with the wordprocessor - you may
have to select a Cyrillic font to display the Russian text correctly.

EEX

File Edit Yiew Insert Faormat Help
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IIpenHasHaYeHHEM CHCTEME] ONTHY2CKOT0 PACIIOSHABAHHI 3HAKOE ABIASTCA
ABTOMATHY eCKHi BEOJ [Ie4aTHELE [ OKYEeHTOE B [IaMATE KOMIBEOTepa KpaliHe
s der T DM M EBEIM Ty TEM. HecMoTpa Ha To, 4To paspaboTia sTof

CHCTENE @ MpedNpHHATA ellfé 20 NeT Hasaf, 5Ta TeFHONOTHA ellé [ToKa

_an) Hy6m~11ce A ABTONMATHYECKOTO BEOOA MATepHANa 11

AOKYVIVMEHTOR.

MM

JFor Help, press F1

To mix other languages, simply select the language with the most extended
character set. If you have a document where the, say, French translation is placed
alongside an English text, you have to select French as language to ensure that
the accentuated characters such as ¢, ¢ and u get recognized correctly.

DEFINING THE DOCUMENT CHARACTERISTICS

Now that the language is set, we’ll turn to the other document characteristics.
You can fine-tune the recognition by specifying some document features: the font
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type and character pitch. (These commands do not apply to Asian documents.)
Let’s clarify what this means.

Let’s start with the command "Font Type" under the "Settings" menu. The font
modes separate “normal” documents from dot matrix printed documents. “Draft”
or “°9 pin” dot matrix symbols are made up of isolated, separate dots, and highly
specialized recognition routines are used to recognize them.

ape—descended life

“Letter quality” dot matrix printing, also called “25 pin” or “NLQ” dot matrix,
requires the “normal” setting, as do the printing qualities typeset, typewritten,
laser printed and inkjet printed.

The setting "Automatic" means that Readiris will detect the font mode auto-
matically. Let Readiris “auto-detect” the font mode in all cases - unless you are
sure only dot matrix documents are being read! (Obviously, "Automatic" is the

default value.)
Font Type o utonaic ) |
Dk Makriz

The font type is indicated in the tooltip of the "Recognize" button: when no
message is added to the tooltip, the “auto-detection™ of the printing quality ap-
plies, when the message "Dot Matrix" shows up in the tooltip, the dot matrix
reading mode is enabled.

The character pitch can be set with the command "Character Pitch" under

the "Settings" menu.
Character Pitch M
Fixed

Proportional

e Perform text recognition: Dok Matrix

With fixed or “monospaced” fonts, all symbols of the font have the same
width. An "i" takes up as nuch horizontal space onaline as a
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"w', as is the case in this sentence. Think of documents produced
using a typewriter, where the carriage moves a fixed distance for each typed
symbol.

A proportional pitch means that the width of a character depends on its
shape. Symbols like “m” and “w” are wider, take more horizontal space on a line
than the “thin” characters “1” or “§”. Virtually all books, magazines and newspa-

pers are printed in proportional pitch.

The simplest solution is to leave this option at all times on the default value
"Automatic", which means that Readiris will detect the character pitch automati-
cally.

READIRIS GETS MORE INTELLIGENT EACH TIME!

When the document language is selected and document characteristics are
set, enable the interactive learning and click the "Recognize" button.

E

=
- )
Learn Recognize

The OCR progress is indicated on-screen. You can click the "Stop" button to
abort the text recognition.

OCR in progress
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At the end of the recognition, Readiris enters the interactive learning phase
when the learning is enabled with the "Learn" button on the main toolbar.

(Interactive learning does not apply to Asian documents: learning does not
make sense for these languages which use thousands of different symbols - and
you’d have to be able to enter the ideograms, not an easy task when using a
Western keyboard!)

Font training can substantially enhance the accuracy of the recognition sys-
tem. When the user tries to read distorted, defaced forms as are found in real
documents or stylized font shapes which Readiris does not recognize optimally,
training can overcome this temporary “failure”.

User learning is also used to train the system on special symbols which
Readiris is unable to recognize, such as mathematical and scientific symbols and
dingbats. Some examples: Readiris can be trained to recognize the "n" symbol as
"pi" or the dingbat "&" as "Tel". (However, the list of recognized symbols cannot
be extended with the symbols "n"and "&"!)

The recognized text is displayed progressively and the system stops on doubt-
ful characters, or - if you are dealing with touching characters (“ligatures™) - on
doubtful character strings. They are always presented in their context, the doubt-
ful characters are highlighted. Unrecognized characters are represented by a
tilde (the "~" symbol).
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Mew Dictionary: C:\My Documents\Readiris.dus

835

Learn

Delete

Undo

1885 -

Abort ‘

Dion't learn ‘

The first thing you should do is verify if you activated the correct font dictio-
nary and dictionary mode - these are always indicated in the title of the learning
window. If that is not the case, click the "Abort" button - the document image is
redisplayed with the zoning as was created -, enable the right font dictionary or
dictionary mode and run the OCR again. (The operation of font dictionaries will
be discussed shortly.)

If necessary, enter a character (or character string) for the incorrect or un-
known shape and click one of the following buttons.

Learn

You agree with the proposed solution or correct it. The program saves this
doubtful character in the font dictionary as “sure”, final. Future recognition will

no longer require your intervention, the shape is considered learnt once and for
all.

In the example above, the system stops on a soiled character, and we click
"Learn" to accept a shape which cannot be confused with other characters.
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Don’t Learn

You agree with the proposed solution or correct it. The difference with the
"Learn" button is that the learnt symbol gets the status “unsure™ in the dictionary.
For future recognition, the system will propose the “learnt” solution but still re-
quire a confirmation.

This button is used for symbols which might be confused with others: a de-
faced "e" which might be mistaken for a "c¢", a damaged "t" which closely re-

sembles an "r" etc.

Mew Dictionary: C:\My DocumenisiReadiris.dus

mﬂ Learn |

Don't leam ‘

Delete ‘

Undo ‘

Whitney-(8)-{(| =~ |
| @ Abort ‘

The "¢" above is seriously damaged - in fact it is close to the "¢" symbol -, and
you should click "Don’t Learn" so as not to confuse the two symbols.

Delete

The displayed form is eliminated from the output. This button is used to ignore
“noise” on the documents - spots, coffee stains etc. - which might get recognized

as points, commas and what have you -, and to erase any other unwanted sym-
bol.
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Undo

You go back to correct mistakes. You can undo the nine last decisions.

Finish
The learning process is aborted but the OCR continues in automatic mode. All
decisions by the system thereafter are accepted without user validation.

Click this button when you see that the recognition is highly accurate and does
not require detailled proofreading.

Abort

Don’t confuse "Finish" with the "Abort" button: with "Abort", no output is
generated and you start all over, with "Finish", the text is created, it just isn’t
proofread in detail!

THE RoOLE OF FONT DICTIONARIES

The results of each training session are temporarily held in the computer’s
memory but can and should be stored in files called “dictionaries”™ for future use.

These font dictionaries should be loaded into memory when you want to rec-
ognize similar documents in order to make use of the extra intelligence they con-
tain; in this way, Readiris takes into account the intelligence stored in these font
libraries. You could say that Readiris gets more intelligence each time you use it!

How does this work? The operation of font dictionaries is controlled by the
"Learn" menu: you have to select a dictionary with the command "Font Dictio-
nary" and determine its mode of operation.



Dictionary

Loak in: |E| My Documents j g

My Music
E‘My Pickures
ﬁMy Yideos
Readiris.dus

File name: |Headiris
Files of tppe: |Dictionary j ﬂ

* Mew Dictionany

" Append Dictionary
" Read Dictionary

Font dictionaries are limited to 500 shapes, and you are recommended to
create separate dictionaries for specific applications, for instance per type of
document. Dictionaries have the default extension *.DUS. Training no longer has
effect when the dictionary is full: the results of the learning are no longer held in
memory or written to a dictionary.

You can set the dictionary mode inside the command "Font Dictionary" or
directly under the "Learn" menu. Three dictionary modes are available: new,
append and read.
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W [lew Fonk Dickionaty
Append Font Dictionary
Read Fonk Dickionary

v Interackive Learning

By selecting "New Font Dictionary", you indicate that the training results will
be saved in a new dictionary. (If you select an existing dictionary, its contents will
be erased.)

The append mode indicates that the training results will be saved in an exist-
ing dictionary: the recognition makes use of the extra intelligence already con-
tained in the dictionary, and you add new font shapes to it. In simple terms, this
option allows you to build up a font dictionary in several steps.

(When you enter a filename for a new dictionary and activate the “append”
mode, an empty font dictionary is created and you complete it.)

With the last option, "Read Font Dictionary", the dictionary functions in read-
only mode: you make use of the dictionary without adding new font shapes to it.

Select the new mode when a single page is recognized. To recognize many
pages of the same type - pages with the same fonts and printing quality - select
the new mode for the first page, the append mode for a few pages more and the
read mode for the rest of the document(s).

Know that the tooltip of the "Learn" button indicates at all times which font
dictionary is currently active and in which mode that dictionary operates.

Inkerackive learning: CiyMy DocumenkstReadiris dus (Mew Dictinnary)|

When you enter the interactive learning, the dictionary and its operating mode
are indicated in the window title; you should click the "Abort" button and start
over in case they are wrong.



Mew Dictionary: C:\My Documents\Readiris.dus

Learn

Dion't learn

Undo

ling -

| Em Abart ‘

Delete ‘

SENDING THE RESULT DIRECTLY TO YOUR APPLICATION

The interactive training concludes the character recognition. As Microsoft
Word operates as output target by default, your wordprocessor is started up au-
tomatically at the end of the recognition (if necessary) and the recognized text is
inserted.

You may get a progress bar on-screen as the recognized document gets for-
matted. (Whether this progress bar appears on-screen or not depends on the size
of the document and the complexity of the formatting to be performed.)

Formatting test

s
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The scanned image is displayed again with the zoning as created to be avail-
able for further processing, it stays there until you scan another page.

You have indeed converted a paper document into an editable computer file,
be it 40 times faster than manual retyping! Go ahead and compare it with the
image you have inside your Readiris window.

Actually, Readiris offers three different methods when it comes to saving the
OCR result: sending the recognized document directly to a target application,
saving the result in an external file and copying the result to the Windows clip-
board.

The output target is selected using the "Format" button on the main toolbar
(or the command "Text Format" under the "Settings" menu).



Text Format rz|
Output
& Sendto [Microsaft word 57 /wiord 2000 /wiord 2002~ |
" External file | J

[ Open after saving

Layout
(™ Create body test

™ Retain word and paragraph formatting

* Recreate zource dacument

I¥ Use columnz instead of frames

Options

¥ Merge lines into paragraphs
W Include graphics

-

Cancel

The "Send to" feature offers a direct OCR link between your scanner and
your Windows applications: you send the scanned documents directly to your
wordprocessor, spreadsheet or web browser, to Adobe Acrobat (Reader) etc.!
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+ Sendta
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Microzoft Wwiord 97/ Waord 2000 /wiord 2002

=

" Extemal file

I
Lapaut
" Create body text
" Retain waord and paragraph fq
* Recreate source document

¥ Usze columns instead o

Options

&biS ource Abiwiard
Adobe Acrobat [Reader] - Image-Text
Adobe Acrobat (Reader] - Text
Clipboard

Clipboard Microsaoft Excel
Corel WiordPerfect

HTHL editor

Jarte 1.8

Microzaoft Eucel

Microzoft Intemet Explarer

Metzcape

OpenDffice.org YWwiiker 1.0
SoftwareB02 Pra PC Suite
Sun Star0ffice 6.0

Wieb brawser

WordPad

At the end of the recognition, the target application is started up and the rec-
ognized document is opened inside a new text file or worksheet.

Pleaze wait while lnading Microsoft

Wwhord 97

Awiord 2000 4 %word 2002

Don’t forget that the option "Send to" also allows you to copy the recognized
text to the Windows clipboard, so there is no strict need to export the result... or

save 1t to an external file!

SAVING THE RESULTS IN A TEXT FILE

You can indeed write the OCR result to an “external” file. Here again, Readiris
supports a wide range of file formats incorporating all popular wordprocessors,
spreadsheets, web applications etc. - Microsoft Word (DOC), RTF (“Rich Text

Format™) and HTML etc.



Output
" Sendto
f+ Extemnal file
[V Open after saving
Layout
(7 Create body text
" Retain waord and paragraph b
f+ Recreate zource document

v Use colurng instead ol

Ophions
v Merge lines into paragraphs

v Include graphics
-

[

|Micmsofl Word 97, 2000, 2002 [*.doc)

Led Le]

AbiSource Abiviord [%.rtf)

Adobe Acrobat POF Image-Text [ pdf]
Adobe Acrobat PDF Test (% pdf)

Corel WordPerfect 5., B.x, 8w, 9, 10 [*.1tf]
DCA [*.dca)

Displayarite [*.dw |

HTML [* k]

Jarte 1.1 [*.rtf)

Lotus WardPra [AmiPra) (=)
Microsoft Excel [*.cav]

Microzoft Excel [* htni)

Microsoft Excel tab. [*.tat)

Microsoft Word 2.8 [* doc]

Microzoft Ward 4

ord [
MlcrosoftWorks 4 5 5 EI 6.0 [*.wpsz)
Fdultibd ate [*.mm |
OpenDffice.org Witer 1.0 (.1t
Rich Text Format [%.rtf)
SoftwareB02 Pro PC Suite [*.rtf)
Sun Star0ffice Bx (<)
Sun Star0ffice 6.0 [*.1tf)
Teut - MS-D0OS Farmat [#.t=t)
Test [* bat]
Unicode [*.txt]
Unicode UTF-8 [*.txt)
WiardPerfect 4.2 [wp
WordStar [*ws |

WiordStar 2000 [%wms2]

The option Open after Saving is largely similar to the “send” feature: you open
the recognized document once it’s saved.

Output

" Sendto |

% External file |Microsofl Wword 57, 2000, 2002 [*.1tf)

v Open after zaving

I
[
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However, the method used to address the target application is different. This
time, the Windows file types determine which application will be started up. It’s
as if you double-clicked the output file in the Windows Explorer... (With the op-
tion "Send to", Readiris addresses specific target applications directly.)

Folder Options

General | Wiew | File Tupes | Offline Files

Regizterad fils types:

Extenzionz  File Tppes L

Microsoft Excel Data Interchangs Format

=1

e o] Microzoft Word Document
DDCH... Microsoft Word HTML Document
ﬁDDEM... DOCMHTML File

DDT icrozoft Word Template
DDTH... Microzoft \Wiord HTML Template

[ At % ¥H B Crimnd ONDE Clavnn filmn h]

Mew ][ Delete ]

Dietailz for 'DOC" extension

Opens with: [ Microzoft Word

Filez with extenzion 'DOC" are of type Microzoft Word Document’.
To change zettings that affect all 'Microsoft Waord Document’ files,

click Advanced.

I 0K H Cancel ]

CREATING PORTABLE DOCUMENTS...

We’ll go deeper into one format: Adobe Acrobat PDF. Readiris allows you
to create PDF documents of two types - PDF Text and PDF Image-Text.



COutput

* Sendto Adobe Acrobat [Reader] - Image-Text ﬂ
AbiSource Abiword

™ External file

Adobe Acrobat [Reader] - Image-T ext
Adobe Acrabat PDF [Reader) - Test (= pdf] k

4 Clipboard
Clipboard Microsoft Excel
Lapaut Corel WordPerfect
Output
™ Sendta | J
{* External file |Adobe.&cmbat POF Image-Text [*.pdf) j

AbiS Abiaford [*.atf
v Open after saving S A ST

Adobe Acrobat PDF Imane-Text [*
Adobe Acrobat POF Test [* pdf)
Lapout Corel WordPerfect 5., B.x, B.x, 3,70

What’s the difference between the two? When you select the format "PDF
Text", Readiris creates a PDF file that contains the text result. (Graphics may
occur but only when graphic zones occur on the page - photographs, artwork

etc.) In other words: the page image is not contained in the single-layered PDF
file!
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3%

1of1

]b%B&l@

Autoformatting

The aim of "autoformatting” is to recreate a facsimile copy of

the original document.

he OCR process does more than just
recognize your text, it can format it for
you too!

In a way, fext recognition is becoming
more and more page rcognition or document
Tecognition. ..

Whether your OCR. software reformats
the recognized text or not is up to the user,
You can perform OCR because you just need
the text, in which case you will edit and
format it yourself, and you can recreate the
source document, including its formatting.

The wvaricus levels of
: creati body
the word and
paragraph formatting and
creating a faceimile copy.

Creating body text means no
formatting is applied: you
get a continucus, running
text. all formatting, if
any, is done afterwards by
the user.

It you refain the word and paragraph formatting,

the font type. sime and typesiyle are maintained
across the recognition. The justification  of the
paragraphs is also detected. However, no graphics
are captured and the columns aren't recreated -
the paragraph just follow each other de.

"Autoformatting”  recreates a facsimile
copy of the original document: the text
blocks, graphics and tables are recreated in
the same place and the word and
paragraph  formatting  are  maintained
across the recognition.

[CeTTA 1 Tnmale ]
Cell 2A Warden
Cell 3A | $100,000

As aresult, you get atrue copy of your source
document, be it a compact and editable fext
file, no longer a scanned image of your
document!

W1 Coyright Imge Temguitics Dstegrabed System

FoMTESx 221 2 mm

o

The format "PDF Image-Text" yields different results: Readiris creates a
searchable PDF file that contains the recognized text and the page image. The



page image is contained above the text in a two-layered PDF file. Use the "Search"
tool of Adobe Acrobat (Reader) and this becomes quickly obvious!

& Adobe Acrobat - [Autoformat. pdf]

'EFiIe Edit  Document  Tools  View  ‘Window  Help
DEARESA@- MA-E K> e 0= -@ DOB|®-
B-&B-7-£- B4 BSUHEET-

Autoformatting

The aim of “autoformatting” is to recreate a facsimile copy of
the original document.

tham The various levels of
e [ process docs ! Just formatting are: creati b%y
Al

recognize your text, it can format it for text, retaining the wo
you too! par&gpaph formatting and
creating a facsimila copy.

Find What: | S8 Eind Again |
I Match Whoale Ward Only Cancel .
| prmarting,

I Match Case haintained
: Jou of the

I™ Find Backwards o araphics
jecreated -

I~ 1gnore Asian Character Width

Click the "Format" button to discover an option that concerns the Acrobat
PDF format: "Create Bookmarks".

Options
¥ Merge lines into paragraphs

¥ Include araphics

v Create bookmarks

The option "Create Bookmarks" sees to it that a bookmark is created for
each document clement - the graphics as well as the text blocks and tables. For
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the text zones, Readiris applies an intelligent algorithm to come up with a title, a
“summary” per zone; the tables and graphics are simply numbered. (Another
navigational element of PDF documents, page thumbnails, can be created dy-
namically by your Adobe Acrobat (Reader) software!)

E& Adobe Acrobat - [Autoformat. pdf]
'EFiIe Edit Document Tools Yiew Window Help

ERESE®- #E-E |44 b
mE - T-E B -L-BS B0

Bl @ B Bookmark =
4 Aut

The aim of "at

E& Adobe Acrobat - [Autoformat. pdf]
'EFiIe Edit Document Tools Yiew Window Help

ERESE®- #E-E |44 b
mE T B -L-BS BN

jinj ThumhnailvJ Aut

The aim of "at
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Bookmarks
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«ee OR READING THEM

Let’s look the other way for a moment. As Readiris offers full support of the
Adobe Acrobat PDF format, you won’t just generate PDF files, you can also
read them!

“Repurposing” PDF documents may be a major application of Readiris.
There are several reason why this is the case. First of all, it’s a way of converting
images into text: open image-based PDF documents, execute the recognition and
save the OCR result to a text document (in any supported text format). Text files
are editable, image files are not.

Second case: you can convert image-based PDF files to text-based PDF docu-
ments. You then execute the recognition on “image-only” PDF files and save the
OCR results... as text-based PDF documents! Text-based PDF files are search-
able and editable, “image-only” PDF files are not.
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Finally, converting PDF files is a way of “unlocking” PDF content. You can
recognize “read-only” PDF documents, where the text is normally inaccessible.
With unprotected PDF files, the content can be retrieved (copied and saved to an
RTF file), with “read-only” files, the content cannot be extracted. These docu-
ments can only be viewed and printed!

An important nuance: Readiris does not open password-protected PDF docu-
ments, even if all other PDF security barriers are broken down by Readiris!

Proceed as usual: load PDF files into memory as you open prescanned images
- faxes, snapshots made with your digital camera etc. Still, there’s a specific
option that concerns PDF files. You can open them as color and as black-and-
white documents! This option is offered because rasterizing color documents is
much slower!

Look in: |l’f} Fieadirs j & =5 B

@ sample

File: name: |
Files of type: |PDF [*.pdf] j Cancel

[~ Digital camera

[™ Force a: 300 dpi

[ Smoothen colar images

v Load PDF documents in color
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REcoGN1zING MULTIPLE PAGES

After the OCR, the scanned image is redisplayed with the zoning as created
to be available for further processing.

You can now open the recognized text with your wordprocessor or text editor,
import it into your desktop publishing software or any other text-based applica-
tion. Go ahead and compare it with the image you have inside your Readiris
window.

But how do you save the text of additional pages? Or in other words: how do
you process documents consisting of multiple pages? It’s actually very simple: go
on recognizing pages. but enable the option "Append" when you are saving to the
same file! (If you append an existing file, be sure it isn’t currently open, because
that will prevent you from writing to it!) Secondly, don’t forget to put the font
dictionary in the append mode so that you can continue the font training comfort-
ably.

File narne: |Headiris

Save az ype; |Microsofl whord 97, 2000, 2002

¥ Append

As soon as you scan pages (or open image files) inside a document, you have
to decide whether you want to start a new document or complete the current
document.

Readiris

Are vou ready to delete the current document?

Yes Mo Cancel |
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Answer "no" to add pages to the current document, answer "yes" to create a
new document. This answer has the same effect as the command "New Docu-
ment" under the "File" menu.

Mew Document

But there’s a more efficient way of recognizing several pages than scanning
and OCRing them one after the other: processing multipage documents di-
rectly!

To scan a document composed of several pages in one operation, enable the
document feeder of your scanner with the option "ADF" under the "Scanner"
button.

™ Landscape

¥ ADF
. [ Irwert
= If I Digital camera
Scanner I Force as 300 dpi

I Smoathen color images

Place the pages of your document in the automatic document feeder and start
the scanning: all pages are scanned until the document feeder is empty.

You can also open multiple prescanned images. To load several images, se-
lect the first image and hold down the Ctrl key as you select additional images. To
load a continuous range of images, select the first image and hold down the Shift
key as you select the last image.
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Lok, ir: Jlﬂ Readiriz _:j l:j( Ea-

= Ltj deskew Ltj areek. Liﬂ multipag Ltj
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< I >

alphabet tif"' "autaforn. jpg” Open I
Files of tupe: ],-’.\II image files :_j Cancel 1

[ Digital camera
[ Force as 300 dpi
™ Smoothen color images

File narme: 1"english.ipg

™ Load PDF documents in colar

The same effect can be obtained comfortably from within the Windows Ex-
plorer: select several image files, right-click and select the command "Recognize"
from the "Context" menu. You can repeat this operation: all images you send to
Readiris append the current document until you click the command "New Docu-
ment".
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You can even drag several prescanned images from the Windows Explorer
onto the Readiris window! The same argument holds: all images you drag onto
the Readiris window are added to the current document until you click the com-
mand "New Document".

Readiris sorts the images automatically - image 001.tif precedes 002.tif pre-
cedes 003 tif etc.

The page toolbar on the right side - it is displayed as soon as pages get
processed - represents the various pages of the document and gives access to
the page commands (using the right-click).
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The current page is highlighted in the page toolbar and mentioned in the Readiris
title bar.

The page toolbar comes with a tooltip: hold your mouse pointer over a page
thumbnail to learn which image was loaded into the memory. (If a multipage
image was opened, there’s obviously just one file for all the images.) When you
are scanning multipage documents, the tooltip simply mentions the scanner model.

X X
HF Scanlet 5470C C:\Readirisiautaform. jpg T
il il

Load the sample image MULTIPAG.TIF and start the recognition. The vari-
ous pages are displayed one after the other; the Readiris title bar indicates the
page number.



'8 Readiris - C:\Program Files\Readiris\multipag.tif (page 2 of 5)
File:Edit: -Settings: Miew: - Process Learn: Register: Help
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All are equal before the law an- 3 5 arion to equal protection of the
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did not constitute a penal offence, under national o nternationat law, at the time when it

If the interactive learning is enabled, you go through the recognition and learn-
ing phases page by page. The dictionary mode "New" is used for the first page
and the mode "Append" for the successive pages.

When you click the "Finish" button, all decisions by the system thereafter are
accepted without user validation. In other words, the interactive learning is aborted
for all pages; the OCR for this document continues in automatic mode.
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The recognition result of multipage documents is saved in a single output file.
When the recognition result is sent to a target application, multiple pages get
created inside a single document.

EDITING MULTIPAGE DOCUMENTS

The user can edit multipage documents, mainly to correct scanning errors: he
can delete pages from the document and move pages to other locations in the
document.

The navigation first. To go to a page, click on its icon in the page toolbar or
hold your cursor over its thumbnail, invoke the "Context" menu by right-clicking
and use the command "Select Page". To go to the previous page, you can use the
shortcut PageUp, to go to the next page, press PageDn. Or use the correspond-
ing commands under the "View" menu.

Previous Page k Pagellp

Mexk Page Pagelown

Let’s edit the document now. To delete a page from the document, hold your
cursor over its thumbnail, right-click it and use the command "Delete Page". To
move a page up in the document, use the command "Move Page Up", and to
move a page down, use the command "Move Page Down".

T

Delete Page 4
Move Page 4 Up
Move Page 4 Down

EILE]]
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STARTING A NEW DOCUMENT

You can use the command "New Document" under the "File" menu to close
the current document.

Mew Document CErl+M

This command “cleans the slate”. Any document loaded into memory - con-
taining a single page or multiple pages - is erased. You are now ready to create a
new document.

But you can also create a new document from within the current document.
As long as the OCR was not executed, the system assumes that you want to add
pages to the current document. You can for instance scan all the pages in the
scanner’s autofeeder, fill the feeder again and start over. All pages scanned will
compose a single document. Or you could scan a number of pages and add some
image files, say, faxes. These pages again form a single document, all you have to
do is change the image source in between with the "Source" button.

When the OCR was already executed and you re-initiate the scanning (or the
loading of images), you are prompted to start a new document or complete the
current document.

Readiris

Are you ready ko delete the current document?

Yes Ma | Zancel |

ORGANIZING THE TEXT QUTPUT

Saving or exporting the text means more than selecting an output method or
defining a filename for the output file. You also select a file format and determine
the appearance of the recognized text. In short, you have to decide where you
want to take the text before you launch the execution.
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Some options of the "Format" button allow you to influence the look of the text
output.

The text flow of the output document is directly influenced by the option
"Merge Lines into Paragraphs".

Optionz
Iv Merge lines into paragraphs

I Include graphics
=

Keep this option enabled to have Readiris detect the paragraphs: Readiris will
then apply the normal wordwrap typical of wordprocessors, otherwise, a car-
riage return is added after each line and hyphenated words remain so! Paragraph
detection is enabled by default.

Let’s give an example to clear things up. When the first three lines of a col-
umn are "The new presi-", "dent waved from the balcony." and "His wife had
joined him.", the paragraph detection gives you the following result: "The new
president waved from the balcony. His wife had joined him." The hyphenated
parts of the word "president" were “reglued” and a space was added at the end
of the first sentence, thus creating naturally flowing text.

Had paragraph detection nof been enabled, the original layout would have
been retained, with a carriage return added at the end of each line.

This option is not available when the PDF format is selected: Adobe Acrobat
PDF files always store text line by line!

(The "Format" button contains some formatting options we haven’t discussed
yet - this will be done shortly.)

SETTING UP YOUR SCANNER

Let’s set our scanner up now. It is assumed that the scanner hardware and
necessary drivers are installed correctly.
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If your Readiris software licence was bundled with a scanner or digital cam-
era, this step probably is unnecessary as your hardware may already be set up
under Readiris.

Click the "Scanner" button on the main toolbar.

Click the button "Scanner Model" to determine your scanner model.

Type
P Format;
HF Scanlet 5470C b4 had
Config...
Scanner Model... | Q
Cahicel
Resolution:
300 =
Bright
nghtness | * Black-and-white [
J " Greyscale [ Invert
lighten daken ¢ Coler [ Digital camera
[ Force as 300 dpi
v Optimize resolution for OCR " Smoothen colorinages

When you select the option "<Image>" as “scanner”, prescanned images func-
tion as image source at all times - you won’t have even to select the disk as image
source with the "Source" button on the main toolbar.

The "Config." button is only available when you scanner allows it. It gives
access to some advanced scanning parameters; with Twain scanners, clicking
the "Config." button allows you to select the Twain source. (You can also use the
command "Select Source" under the "File" menu.)
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Select Source El

Sounces:
HF Frecizionzcan Pro 3.1

IBCR 1.2
Wid-Hewlett-Packard Scandet 4400C 7.2

Cancel

Once the scanner is selected, the same window may allow you to set the
scanning resolution, the page format and orientation, brightness and contrast and
may allow you to indicate whether you are going to use the scanner’s document
feeder. With Twain compliant scanners, all scanning parameters are often set
inside the Twain interface.

Set the brightness, and, if available, the contrast.

By enabling the option "Landscape", you indicate that the selected page orien-
tation is wide (“landscape™) instead of tall (““portrait™). The page orientation actu-
ally applies to reduced page formats: on an A4 flatbed scanner, you can scan, say,
A5 pages (half that big) in portrait or landscape format, but you can obviously
only scan the full A4 surface in one direction!

A4 A4

The option "Invert" allows you to generate “inverted” images in the black-
and-white scanning mode - you can activate this option to process full pages with
white text on a black background.
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BRING COLOR TO YOUR TEXT SCANS!

Readiris supports black-and-white, greyscale and color images on an equal
basis, so you are free to choose the color mode that best suits your needs. To
include lineart graphics in the recognized documents, scan in black-and-white, to
include black-and-white photos, scan in greyscales, to include color pictures, scan
in color.

But why would you reduce the bit depth of the images during the scan? It goes
without saying that greyscale and color images are slower to acquire and require
more RAM memory than “bilevel” images.

Scanning in greyscale and color isn’t just useful to save the graphics with
sufficient quality, in some instances, it’s also useful or necessary to obtain good
OCR results! When text is printed on a color background, scanning in color may
create the tone differences that are lacking in black-and-white images. When
there is only limited contrast between the text and the background, the back-
ground can create “noise” that renders the recognition difficult or impossible!

Think for instance of black text printed on a dark background: when scanning
such a document in black-and-white, you may not be able to “drop” the back-
ground color without losing the text information as well, as much as you may try
to adjust the scanner brightness...
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Readiris creates a black-and-white version for every greyscale and color im-
age. Thanks to its intelligent routines, even tough cases get solved - here’s how a

“difficult” image gets binarized!
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To view a scanned image in black-and-white, disable the option "Display Docu-

ment in Color" under the "View" menu.

v Display Document in Color  Cerl+0
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D1FFERENT DEVICES, DIFFERENT RESOLUTION

Whatever your scanning mode may be, use a scanning resolution of 300 dpi
for normal applications. Use a higher resolution of 400 dpi for small print (below
10 point) and when the document is very degraded.

Readiris reads point sizes of 6 to 72 point (0.087 to 1 or 0.21 to 2.54 cm).

6 point

72 point

Readiris also recognizes “drop letters™, large caps that cover several lines.
(These can of course be no bigger than 72 point!)

eadiris reads drop
letters (also called
“drop” caps) that

cover several lines and
assigns them to their starting
line.

As optimal OCR requires a resolution between 300 and 400 dpi, Readiris
warns you when you re submitting images with a resolution lower than 200 dpi or
higher than 800 dpi. However, Readiris can correct scans with too much detail
for you! Enable the option "Optimize Resolution for OCR" in the scan settings to
do so. Whenever the image resolution of your scans exceeds 600 dpi, the resolu-
tion is reduced for the OCR process.

[+ Optimize rezolution for OCR

There are other ways of avoiding this warning: you may be reading faxes -
which have a resolution of 100 or 200 dpi -, when you’re creating images with a
digital camera - where the resolution is unknown - and when you’re opening
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images where the file header contains an incorrect resolution. To process such
images hassle-free, enable the option "Force to 300 dpi". This setting applies to
both direct scanning and the opening of prescanned images.

[ lrevert [~ Digital camera

[ Digital camera W Force as 300 dpi
[¥ Force as 300 dpi

. [ Smoothen color images
| Smoothen colar images

[ Load PDF documents in colar

When your images are acquired by a digital camera instead of a scanner, it is
mandatory that you enable a special option (that also applies to scans and
prescanned images).

[ lrevert [v Digital camera

¥ Digital camera W Force as 300 dpi
[¥ Force as 300 dpi

. [ Smoothen color images
| Smoothen colar images

[ Load PDF documents in colar

By doing this, you enhance the image before it gets recognized. There are
specific challenges to be met when it comes to digital cameras: they produce
low-resolution images - even when you hold the camera very close over your
document - and the image resolution is in any case unkown.

There are some “finer points™ to be aware of when it comes to successfully
recognizing images captured with a digital camera.

First of all, select the highest possible image resolution. Create for instance
2,048 x 1,536 size images when 1,024 x 768 and 640 x 480 images are also
supported. Secondly, enable the “macro” mode of your camera to take closeups
- which is always the case when you photograph documents. (This mode was
designed to capture flowers, insects etc.) Otherwise, the images are unsharp and
illegible.



Limit yourselfto no or small compression: important compression reduces the
sharpness of the captured text. Zoom manually to crop your document - some
cameras are bundled with photo stitching software, but don’t bother using it for
document capture.

Hold the camera directly above the document to avoid capturing the docu-
ment at an angle. However, avoid shadows cast on the document by the camera
or your hand! Produce stable images. Consider mounting your camera on a tripod
when necessary.

Disable the flash when you’re filming glossy paper, otherwise the image may
be too light. Generally speaking, adapt the brightness and contrast to the environ-
ment - day light, lamp light, neon light etc. (Some cameras can be calibrated by
filming a white document.)

ey ﬁ”‘_/

To give it a try, open the image DIGITAL.JPG in the Readiris folder and
execute the recognition.
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8 Readiris - C:\Program Files\Readiris\digital. jpg (page 1 of 1)

Fle Edit Settings View Process Learn Register Help

SAVING DEFAULT SETTINGS

Set all scanning parameters correctly and click the command "Save Default
Settings" under the "File" menu to save the current settings as default settings for
future use.

ave Defaulk Setkings

Settings files contain more than the scanner settings: they also determine
whether you are going to use interactive learning, which language the documents
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have, which output mode is used - for instance send text to WordPad - etc. In
short, all operational settings of Readiris are stored in the settings files.

SAVING SPECIFIC SETTINGS

The default settings will obviously be used at each program startup, but you
can save specific settings as well to avoid having to redefine the operational
parameters. The commands "Save Settings" and "Load Settings" under the "File"

menu take care of this.
Save Settings... !

Save Defaulk Settings

Let’s give an example: if you regularly have to OCR English documents with
a specific layout, you are recommended to create a settings file for this type of
document. You would then select "English" as the document language, load a
specific zoning template to avoid having to reapply the same windowing each
time, disable learning but activate a font dictionary in the “read” mode because
the same typefaces are used systematically etc.

If you are unsure what the current settings are, you don’t have to “plunge”

into every menu and command to discover what they are. You can use the com-
mand "Info" from the "File" menu to get an overview.
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Information on settings

Scanner

kodel HPF Scanlet 5500C

Resolution 300 dpi

Format A4 Text
Format ticrozoft Word 37 A word 2000 /word 2002
. Paragraph On
Mode Black-and-white Layout Fecreate source document

Landzcape Off
Document
Font Type Automatic Language Englizh

Page
Reszalution

SCANNING DOCUMENTS

Now that our scanner is set up, we want to get started scanning documents.
There are some elements you should be aware of.

First of all, pay some attention to lineskew. Although the page analysis and
recognition are skew-tolerant, it may become difficult to window and OCR a
page correctly when the skew is too significant. Limited lineskew (less than 0.5°)
can be ignored because the OCR accuracy does not suffer.

The option "Page Deskewing" under the "Settings" menu determines whether
pages which were scanned at an angle will be deskewed, straightened auto-
matically - limited lineskew gets ignored. This option is disabled by default.

If you forgot to enable this option, use the "Deskew Page" button on the image
toolbar (and the command "Deskew Page" under the "Process" menu) to
“straighten” pages which were scanned at an angle.
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The deskewing takes a few seconds: the image is analyzed to detect the skew
angle - if any -, the color or greyscale image and its black-and-white version are
deskewed and the page analysis gets re-executed.

Detecting lineszkew Dezkewing

You may also need to adjust the page orientation. Use the rotation tools on
the image toolbar. (Corresponding commands are found under the "View" menu.)
Three rotation directions are available: to the left, to the right and upside down.
Rotation also takes a few seconds as the image itself is updated, not just the
display on-screen.

il
)

1
iy

Rokate Right [g

Turn Upside Down

)
|

However, Readiris can correct badly oriented pages for you. Enable the op-
tion "Detect Page Orientation" under the "Settings" menu and Readiris will cor-
rect the page orientation where needed.

Detect Page Crientation

You can make good use of the image DESKEW.JPG in the Readiris folder if
you want to try it. Enable the options "Page Deskewing" and "Detect Page Ori-
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entation" before you open the image and let Readiris restore the Tower of Pisa
the way we like it.

& Readiris - C:\Program Files\Readiris\deskew. jpg (page 1 of 1)

File Edit Settings \Wiew Process Learn Register Help
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ADJUSTING THE SCANNED IMAGES

As was already indicated, powerful intelligent routines automatically convert
color and greyscale images into black-and-white. Should this still be necessary,
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the user can optimize the image further for the consecutive OCR process. Select
the command "Adjust Image" under the "Process" menu to do so.

Adjust Image. .. Chrl+3

When you access this command, the black-and-white version is displayed
automatically. (It’s as if you disabled the option "Display Document in Color"!)
There are some complicated concepts here, and we need to discuss them in
detail.

Adjust Image

¥ Sroothen color image

With some zcanner models, reduction of the
sharpness iz needed to recognize color and
areyscale images.

Smoothening allows to separate the text from
the colored background
. C |
Brightress LI
i+ Automnatic Apply

" Manual
Help |

j S—

Despeckle; off

|
J
0 20

The option "Smoothen Color Image" renders greyscale and color images more
homogeneous by “flattening”, smoothing out relative differences in intensity. As a
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result, a stronger contrast is created between the foreground - the text - and the
background - a color, artwork etc.

This preprocessing feature may seem highly technical and difficult to under-
stand, but it certainly has its role to play: with some scanner models, this reduction
of the sharpness is needed to recognize color and greyscale images. Smoothen-
ing is sometimes the only way separate text from the colored background! Below
is a sample image that is simply illegible without image smoothing.

IN QUEST OF CALYPSO
from only £1,650.*
16 nights. 9th - 25th Oct 2000.

The image smoothening can also be enabled when you load prescanned im-
ages into memory!

Files of type: Iﬁll image files

[ Digital camera

[ Force as 200 dpi

¥ Smoothen color images

™ Load POF documents in colar

The brightness now. By “brightness”, we actually mean the black-and-white
threshold. The setting "Automatic" determines the bilevel threshold automatically.
Apply a different threshold when necessary by darkening or lightening the black-
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and-white image: when you darken the image, more pixels become black in the
black-and-white version, when you lighten the image, less pixels become black in

the black-and-white version.

Note above all that no image adjustment is executed until you click the "Ap-
ply" button! By clicking "OK", you execute the adjustment and close the window.
Here’s an example where we lightened the black-and-white image dramatically -
though admittedly not with OCR accuracy in mind!

Uhe dectment faorece By sonr s
armd cends e mage Ad s sk
black pemies, oivels oo awehite

informatise frore Urese pisels it

[l snsbonng entorsove sy uses Lz

o Tore ol
s vt e, o hich
mcdule clowes vot Lo vt virle
izleligent vach lme vod s I

2002 Copyrig
Wi

Iv Smoathen color image

“With zome scanner models, reduction of the
sharpress iz needed to recognize color and

grepscale images.

Smoothening alloves to separate the text from
the colored background

Cancel
Apply

Hep |

Brightness
" Automatic
& tanual 57
|
P
lighten darken
Dezpeckle: off
|
p
1] 20

The first two options concern color and greyscale images, the last one,
"Despeckle”, exclusively concerns black-and-white images. “Despeckling” means
that the “parasite pixels™ (also called “salt and pepper noise™) will be removed

from black-and-white images.



USER’S GUIDE

If computers can’t If computers can’t
adapt easily,then  adapt easily, then

maybe the people maybe the people
using them can.©  using them can.

Be sure that you don’t erase spots that are too big, otherwise you might start
erasing the dots on "i" etc., portions of dot matrix letters etc.!

Despeckle: remove 10 pisel datz

[
J

1] 20
Removing too large dots may erase useful
information from the image

The best way of optimizing the images for the OCR process is this: place the
adjustment window where it doesn’t prevent you from judging the image adjust-
ment you execute. Adapt the parameters - clicking "Apply" each time - until the
image is crisp and clear.

LETTING THE OCR WIi1ZARD WORK FOR YOU

Let’s get started capturing documents now. Instead of going through all the
parameters, we’ll use the OCR wizard, a very comfortable way of recognizing
pages.

Click the "OCR Wizard" button on the main toolbar (or select the command
"OCR Wizard" under the "Process" menu).

OCR Wizard,.,  Ckrl+0
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The wizard guides you through the OCR process comfortably: answer a few
simple questions and you’ll obtain quick and easy results with Readiris.

OCR Wizard x]

The OCR wizard leads pou through the OCR process
comfortably,

Juszt anzwer these questions and pou'll get quick rezultz with
Readinis.

Click Mext to begin.

v Enahble ‘Wizard on Startup

| Mewt » | Cancel |

Actually, the OCR wizard starts running each time you start up Readiris; you
can avoid this by disabling the option "Enable Wizard on Startup" in the first
screen of the wizard (and with the equivalent option under the "Settings" menu).

READIRIS RECREATES YOUR DocuMENT LAyouT

The OCR wizard renders the recognition process highly automatic, but “auto-
matic” OCR should not be confused with autoformatting! “Autoformatting” means
that Readiris recreates a facsimile copy of the scanned document: the word,
paragraph and page formatting of your original document are applied.

Similar typefaces (serif and sans serif, proportional and fixed, normal and
condensed) are used as in the source document, the point sizes and typestyles
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(bold, italic and underlined) are maintained across the recognition. The tabs and
the alignment (left, centered, right and justified) of each text block are recreated.
The placement of columns, text blocks and graphics follows your original docu-
ment.

In other words, Readiris allows you to archive a true copy of your documents,
be it a editable and compact text file instead of a scanned image!

All this implies that the sorting of windows only partially applies when
“autoformatting” is used: you can include and exclude zones, but any re-ordering
of zones is simply ignored!

Here’s an example of how it works. To get acquainted with this feature, open
the image AUTOFORM.JPG which is found in your Readiris folder.



I8 Readiris - C:\Program Files\Readiris\autoform. jpg (page 1 of 1)
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Autoformatting

The aim of “autoformatting™ is to recreate a facsimile copy of
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Click the "Format" button on the main toolbar and choose to send the OCR
result to Microsoft Word or select the RTF (Rich Text Format) or Word (DOC)
format. Secondly, select "Recreate Source Document” as layout option. (The
option "Merge Lines into Paragraphs" is enabled by default to apply wordwrap
within the paragraphs.)
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Layout
" Create body text
" Retain word and paragraph farmatting

{* Recreate source document

¥ Use columng instead of frames

Whether layout reconstruction is available depends on the selected output
mode. Some “poor” formats generating “plain” text such as Text (ANSI), MS-
DOS Text (ASCII) etc. do not support advanced formatting codes and therefore
cannot offer autoformatting. The Adobe Acrobat PDF format on the other hand
was designed to copy the look of your documents: PDF documents by nature
imply autoformatting.

When the recognized text is opened using a wordprocessor, the text looks like
this without any intervention by the user.



2 Autoformat - Microsoft Word

File Edt Wew Insert Format Tools  Table  Window  Help - x
DEESH SRV B -
4 Normal + Courier Ne = Courier Mew .
Final Showing Markup = Show~  dar & & ~ K3 ~
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- The amn of "autoformatting” 1s to recreate a facsumile copy of the

original document.

The various levels of formatting

5‘ he OCR process dees more than. Just are: creating body text,

- recognize your text, it can format it for retaining the word and paragraph

- youtoo! formatting and creating a B
w faczimile copy.

In a way, text recognition is becoming

Creating body text means no
more and more page recognition or decument

formatting is applied: you get

o recognition a continuous, running text. All
- formatting, if any, is done
B TWhether your OCR. software reformats afterwards by the user.

the recognized text or not i3 up to the user. Tou
can perform OCE because you just need the
text, in which case you will edit and format it
yourself, and you can recreate the source

If you retain the word and paragraph formatiing
the font type, size and type style are maintained
across the recogmtion. The justification of the
paragraphs is also detected. However, no graphics
are captured and the columns aren't recreated the

a paragraph just follow each other etc

Page 1 Sec Z 11 At 75em Ln28 Col 16 French (Belg O

document, including its formatting.

T

To see the effect correctly, you need to enable the “WYSIWIG™ mode of
your wordprocessor, mostly called “page layout” mode. However, if you send the
recognized document directly to Microsoft Word, the page or print layout view is
activated automatically!
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ent - Microsoft Word

i Document - Microsoft Word —
| File Edit | yiew Insert Format Tools Iil Na;mal = = |
— r 1 i [
|0 o [ s ...
Web Layouk
JN':'r - - ‘ Brin Layout  p |
: M
|EE : Cutline & Cutlire L
Task Pane

In short, Readiris not only recognizes your texts, but can format them for you
as well. OCR isn't just text recognition anymore, it is becoming more and more
page or document recognition as well!

CoLuMNSs PLEASE, NoT FRAMES!

The formatting option "Use Columns instead of Frames" determines #ow the
“autoformatting” gets done: the text blocks, tables and graphics can either be
stored in frames or in editable columns.

“Frames” are separate containers for text used to position several blocks of
text, graphics and tables on a page. With columns, the text flows naturally from
one column to the next, and columnized texts are much easier to edit.

We now assume that real columns do occur on the scanned document: when
the system is unable to detect columns in the source document, this formatting
mode uses frames anyway as a “fallback™ position!

You can make good use of the image COLUMNS . TIF in the Readiris folder if
you want to try it.
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TEXT FORMATTING, PART 2

The other layout options are "Create Body Text" and "Retain Word and Para-
graph Formatting".

As the icon on the right side illustrates, creating body text means you create
a non-formatted, “running” text. The text will be captured, but its formatting is
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entirely ignored. Use this option when you just need to recapture a text but not its
layout.

Layout

% Create body text

" Retain word and paragraph farmatting
" Recreate source document

-

The option "Retain Word and Paragraph Formatting" represents the middle
road: the word formatting - font type (serif - sans serif, proportional - fixed,
normal - condensed), point size and typestyle (bold, italic and underlined) - is
retained across the recognition, and so is the paragraph formatting - the tabs
and the alignment (left, centered, right and justified).

Don’t confuse this formatting option with “full” autoformatting: this option just
puts one paragraph after the other, it does not recreate columns or copy the
relative position of the various zones.

SAVING GRAPHICS SEPARATELY

In our example, the graphic was included in the recognized text; whether this
is the case depends on the formatting option "Include Graphics". Whether it is
possible to save graphics inside the text again depends on the output mode. “Poor™
text formats such as Text (ANSI) etc. don’t store graphics!

Optiong
[ Merge lines into paragraphs

¥ Include graphics
r
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Still, with Readiris, you can save graphics without performing text recognition.
As Readiris generates black-and-white, greyscale and color images, you can
capture lineart graphics and photos.

How? Draw a graphic zone around the illustrations, cartoons etc. you need.
Creating graphic windows manually is done in the same way as drawing text and
table windows, simply select the "Graphic Window" tool now.

Next, choose the command "Save Graphics" under the "File" menu.

BT

You are prompted to specify a filename. Determine which graphic file format
you will use. Select a format that’s supported by your paint or photo retouching
software. The JPEG, TIFF and Paintbrush (PCX) formats are supported. Enable
the option "Greyscale/Color" to save the graphic as a color or greyscale graphic.
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Sawve Graphics...

Save in: 1@ My Documents __v_‘J % Ef-

My Music
[} My Pictures
@My Videos

File name: |
Save as type: 1TIFF [".tif) _:J Cancel i

¥ Greysca Zzaft Paintbrush [, pex) %
JPEG [*.jpg]

READING FAXES AND DEFERRED RECOGNITION

Saving images as image files opens another possibility: you can save the ful/l
page and perform deferred OCR on it later on. That’s what we did with the
prescanned images of our tutorials.

Simply scan the document. Select the command "Save Full Page as Image"
under the "File" menu to save a single page. You’ll again be prompted to save the
entire page as TIFF or Paintbrush (PCX) file.

Save Full Page as Image. ..

Save All Pages as Image. .. k

Select the command "Save All Pages as Image" to save a multipage docu-
ment. A single file format is available here: (multipage) TIFF.
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You can now select the disk as image source and open the image file with the
"Open" button (or with the corresponding command under the "Process" menu).
(If you use the "Open" command under the "File" menu, you don’t even have to
update the image source.)

As color, greyscale and black-and-white images are supported on an equal
basis, Readiris opens Adobe Acrobat PDF documents, JPEG images, Paintbrush
(PCX) images, DCX fax images (a multipage version of the Paintbrush format),
PNG images, TIFF images (uncompressed, LZW, PackBits, Group 3 and Group
4 compressed), multipage TIFF images and Windows bitmaps (BMP).

This capability is particularly useful to convert your faxes into editable text
files! Readiris uses extra intelligence when it comes to reading faxes: the soft-
ware detects the typical fax resolutions - 100 x 200 dpi (“normal quality™), 200 x
200 dpi (“fine quality™) and 200 x 400 dpi (“superfine quality”) - and “prepro-
cesses” these images automatically to ensure optimal OCR results.

Nevertheless, it’s still a good idea to ask your correspondents to send faxes
with the “fine” quality - those faxes will yield better OCR results.

Don’t forget that you can right-click on images in the Windows Explorer and
select the command "Recognize" from the "Context" menu to open images! Al-
ternatively, you can use “drag and drop™: drop image files from the Windows
Explorer onto the image zone or icon of Readiris and they are promptly opened.

RECOGNIZING TABLES

So far, we’ve recognized texts and faxes and we’ve saved graphics. Let’s
process a table now. Take a table of figures and scan it, or open the sample image
TABLES.JPG in your Readiris folder.

Actually, the image TABLES.JPG contains two tables, and that’s no coinci-
dence! The page analysis zones them as table windows, and Readiris will recon-
struct them for you by recreating the tables cell by cell in your spreadsheet or by
inserting a table object inside your wordprocessor files.
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Let’s explore the different solutions, starting with the “gridded” or “framed”
table - it has borders around the cells.

[8 Readiris - C:\Program Files\Readiris\Mables. jpg (page 1 of 1) g@|g|
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Reading Tables

Readiris recognizes tabular data and vecrcates them cell by cell in worksheets
or as lable objecls inside wordprocessor files.
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“IIngridded™ tables don't have any borders sround the cvlls. When the volmms ol uagricddest
Lables arc wo widely spaced. the page analysis may not derect a table window to avind confusion
wirh ¢columnized rext blocks.

Wlhen your lubles exclusively conliins nmeric characters, enable rhe numeric reading mode with
the “1angnage™ mattar on the main toolbar for mereased deenriey.

Run the recognition with the layout option "Retain Word and Paragraph For-
matting" or "Recreate Source Document" enabled and the table gets recreated.
Open your wordprocessor to have a look at the result. (You could obviously have
included the text paragraphs in the text file as well.)
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Now the “ungridded” example - it has no borders around the cells. Note that
the page analysis nevertheless detects the table!
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For optimal OCR accuracy, you should limit recognition to the numeric sym-
bols with the "Language" button. (The numeric mode is not strictly numeric, it
includes the symbols 0to 9, +, *, /, %, , (comma), . (dot), (, ), -, =. $. £, ¥ and the
€ symbol.)

Language

v Numeric

| e
|

Mumeric

Cancel
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As you can only do this when the table doesn’t contain any alphabetic symbols
- otherwise the text portions won’t be recognized correctly - we can activate the

numeric mode now but couldn’t do it for the first table.

This time, we will send the OCR result directly to the spreadsheet Microsoft
Excel, so we select Excel as target application under the "Format" button.

Clutput
* Sendto
" Esternal file
v
Layout
" Create body text

% Retain word and paragraph F
~

Ophions

The spreadsheet is started up automatically and the result looks like this: the
typical table structure with rows and columns is recreated, and you are immedi-

ately ready to process the data.

Microzaft Ewcel

AbiSource Abiw'ord

Adobe Acrobat [Reader] - Image-Test
Adobe Acrobat [Reader] - Text
Clipboard

Clipbaard Microzoft Excel

Corel WordPerfect

HTHL editor

Jarte 1.%
b ft Exc
Microzoft Inte
ticrozoft Wword 37 /wiord 2000 4 word 2002
Metzcape

OpenDifice.org Witer 1.0

SoftwareB02 Pro PC Suite

Sun StarDffice 6.0

Wb browszer

WordPad

=
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B3 Microsoft Excel - Book

File Edit Wew Insett Farmat  Tools  Daka  Window
CeEsasm SAY 8B - @& =-
i3 @ @ 5 =
03 hd Fx
A B © D E

1 123,985 =] 313 23490

2 O57 745 129 24 5589

3 19 149 915 91,549

4 287410 49 526 9812

5 429.000 ] 17 17.429

5] 493123 1439 8 122095

7
& |

You may come across “ungridded” tables the page analysis does not detect as
table zones because the columns are too widely spaced - Readiris tries to avoid
confusion with columnized text blocks. To create a table window manually, click
on the "Table Window" tool in the image toolbar and proceed as usual; the button's
tooltip again indicates the number of table windows.

\@ |Draw table window: EI|

GETTING ON-LINE HELP

This concludes our overview of Readiris. Some last-minute information may
not be included in this manual. We thus recommend you to consult the on-line
help system for additional information on Readiris.

Go to the "Help" menu to do so. The command "Help Topics" and its shortcut
key F1 allow you to navigate through the many help topics.
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Welcome to Readiris™ Help...

e Lse on-ine help to learn more about
Readiris.

» Quickly find answers to questions,

e« Connectto the I.R.I.S, web site for latest tips
and product updates.
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The other commands of the "Help" menu tell you how to get product support,
how to contact .LR.I.S., give direct access to the I.R.I.S. home page etc.
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